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This is the documentation for the Checkbook Management software.    Please select one of 
the following sub-topics for additional information:

Overview of the software
Additional Software
Help Strategy
Revision History

Dedications:
Corinne, who thought I'd invented the software equivalent of a Tinker Toy.
Ron, who volunteered to be 'one of the first'.
David, who was right in line behind Ron.

In addition to the prescribed methods of contacting me, I may be contacted through a 
Bulletin Board known as Companion and Friends 1-714-521-9598, my account number 
there is 282.



Overview of Checkbook software

The Checkbook program was designed to assist in the management of a checking account.    
It allows you to enter Credits and Debits, and to get an updated running Balance as well as a
monthly Statement Balance.    The Checkbook software makes extensive use of DDE 
(Dynamic Data Exchange) to pass information regarding the Checkbook to cooperating 
software.    A brief description of this software is described under the heading of Additional 
Software.



Additional Software

The Checkbook program represents only a piece of a much larger software product.    
Additional programs are available which intercommunicate with the checkbook program, 
updating the checkbook register and providing balance and check number information.    For 
additional information select one of the following:

CheckPrint
CheckWrite
BillManager
Disburse



Help Strategy

Throughout the checkbook program every attempt has been made to document each and 
every field which the user can either view or modify.    Often times, this appears to be 
overkill, but it is done in keeping with the general design concept of the help system.

 Contextual Help is available from anywhere within the program.    By pressing 
SHIFT+F1 or by selecting the Help Contextcommand Contextual Help mode is enabled.    A 
context Cursor is displayed to indicate that you are in Context Help mode, additionally, the 
Caption Bar is changed to reflect this information.    While in Context Help you may position 
the cursor on any field and click the left button for detailed information regarding that field.   
You may also click on the Caption Bar for general information about the specific window that 
the Caption is for.



Revision History

Version 1.0 Initial Release, March 19, 1991
Version 1.1 Released March 20, 1991
Version 2.0 Released April 4, 1991
Version 2.1 Released April 12, 1991
Version 2.2 Released April 12, 1991
Version 2.3 Released April 19, 1991
Version 2.4 UnReleased May 5, 1991
Version 3.0 Beta Release for Disburse May 8, 1991
Version 3.1 Released June 5, 1991



CheckPrint

The CheckPrint software allows the user to print checks on a variety of printers.    Currently, I 
am using an Hewlett Packard LaserJet IIP to print my checks on.    this software works in 
conjunction with the BillManager and CheckWrite software.



CheckWrite

The CheckWrite software allows the user to write 'hand checks' updating the Checkbook and 
printing the check using CheckPrint.    Hand checks are any checks which are not generated 
by the BillManager.



BillManager

BillManager is a software product which keeps track of all of your regular bills in a cardfile 
type fashion.    You may select a bill to pay, or have the software prompt you when a bill is 
due.    It will cause the updating of the Checkbook and print the check using the CheckPrint 
products.



Disburse

The Disburse program allows you to disburse a single payment into several different 
catagories.    This would, for instance, allow you to catagorize a credit card bill based upon 
the types of purchases.

Note
Currently, Disburse allows you to only disburse debits, either from the Checkbook, 
BillManager, or CheckWrite software.    In later version it will allow for the disbursal of credits.



Version 1.0, March 19, 1991

This is the first release of the software.    Although extensively tested, it is the first release.    
I've been using it for about 2 months without any problem, so it is basically stable.    While I 
do anticipate revisions to the software, it appears to be complete.    If you have any 
suggestions for changes, enhancements, or if you find any problems you may contact me at 
the address or phone number specified in the Software 
RegistrationHELPID_DIALOG_REGISTER form.



Version 1.1, March 21, 1991

Okay, so I missed a few things...
I've improved the Register and Entry windows so that the don't corrupt each other 

if you are silly enough to overlap them.
I've added EDIT Copy/Cut/Paste/Delete and updated the HLP file to reflect the 

functionality.
The Entry Clr Checkbox wasn't working, now it is.
I've changed the SELECT/FOCUS handling of the checkbook register.    This is keeping 

in line with the generally accepted methods for handling certain CUT/COPY/PASTE/DELETE 
functions.    I'm not sure if I like how it behaves and further revision of it may be necessary.



Version 2.0, April 4, 1991

I've changed the DDE interface a bit.    Now, if/when the checkbook program goes 
away, any programs that were talking to it are notified.



Version 2.1, April 12, 1991

I've tightened up the program security a bit.    Maybe this will make it less prone to 
being crock'd.



Version 2.2, April 12, 1991

Ok, I released 2.1 on April 11, 1991.    And if the world were to be perfect, I'd be in a lot of 
trouble.    I've fixed a few things that I broke, and added a bit more with this release.

The checkbook now accepts data from the Bill Manager and CheckWrite programs.
I've changed the EDIT DELETE key from DELETE to Ctrl+Delete.
The program is now more cognizant of changes to the checkbook.    Prompting for 

saving before exiting.



Version 2.3, April 19, 1991

I've changed the DLL that manages all of the File Dialogs.    It now provides some 
information about the type of file being manipulated in the Caption.



Version 2.4, May 5, 1991

I've corrected a problem with the File Open.    Previously, it cleared the checkbook 
register even if you Canceled the operation.    Now, it works as expected.

The memory manager routines have been improved to better handle low memory 
conditions.



Version 3.0 (Beta), May 8, 1991

I've added code to support DISBURSE, the bill disbursal program.    Complete docs 
are forthcomming.



Version 3.1 , June 5, 1991

Many of the dialog boxes were changed to use the HELV 8 font.    This provides for 
more information to be crammed onto the screen.

An option to have the entry above the register (default) or register above the entry 
has been added.

A new feature to the register has been added.    A Bar now appears and allows for the 
specification of where paste and move operations will occur.

The Edit Insert command was added to allow for the inserting of new checkbook 
entries.    Precvious this was perforemd with the Insert key, now a menu item has been 
added.

HELP Documentation for the interface to Disburse has been added.
The HELP documentation was extended to include procedures.
The "Pay for it" annoyance box was a bit too annoying!!!    Now, it only comes up 

when you are at the top-level.    This means you can save files, and register the software 
without being hit by this beast.



Dialog:Software Registration Form

Completing this form and mailing it to the directed address, along with the amount of money
specified allows you continuing use of this software package.

For more details select one of the following fields:

Package Name
Package Price
Mail From

Name
Address
City
State
Zip
Phone

Media
3 1/2 Disk
5 1/4 Disk

Add to Mailing List
Obtained From

BBS
Friend
Vendor
Show
Name
Phone

Action
Print



Text:Package

This is the name of the software package that you are registering for.



Text:Price

This is the price of the software package.    In U.S. Dollars, this may be either in the form of a 
check or money order made payable to the name contained in the 'Mail To' box.



Edit:Name

This is your name, or the name of the company who wishes to register the software.



Edit:Address

This is your address or the address of your company.



+Edit:City

This is the city in which you or your company is located.



Edit:State

This is the state in which you or your company is located.    This is also where the Country is 
specified for non-US states.



Edit:Zip

This is your ZIP code (Zoning Improvement Plan - for those trivia buffs).



Edit:Phone

This is your phone number, including area code and country code if you are outside the 
United States.



Button:3 1/2 Disk

This button is used to indicate that you want software shipped on 3 1/2 inch disks.



Button:5 1/4 Disk

This button is used to indicate that you want software shipped on 5 1/4 inch disks.



Toggle:Add to Mailing List

Check this box if you want to be added to the mailing list.    This is how you find out about 
new versions of software as well as other additional products.



Button:BBS

This button is used to indicate that you obtained this software from a BBS (Bulletin Board 
System).    Although not required for registration, this information will be helpful in 
completing this form.



Button:Friend

This button is used to indicate that you obtained this software from a friend.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Vendor

This button is used to indicate that you obtained this software from a vendor.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Show
This button is used to indicate that you obtained this software from a show.    Although not 
required for registration, this information will be helpful in completing this form.



Edit:Name

This is the name of the BBS, Friend, Vendor, or Show that you obtained this software from.    
Although not required for registration, this information will be helpful in completing this 
form.



Edit:Phone

This is the phone number of the BBS, Friend, Vendor, or Show that you obtained your 
software from.    Although not required for registration, this information will be helpful in 
completing this form.



Action:Print

This action button is selected after you have completed the registration form.    It will print 
the form on your printer.    If you don't have a printer, then write the information on paper 
and send it along with your remittance.



Message: Replace existing filename

This message is issued when, as the result of a file saveas command, you would overwrite 
an existing file.

Actions:
YES Causes the file to be overwritten, completing the file saveas command.

NO Causes the file saveas command to be aborted without overwriting the existing 
file.



Message: Save Current Changes filename

This message is issued when, as the result of a File New, or File Exit command, or any other 
command that replaces file data, would potentially cause you to lose your modifications.

Actions:
YES Causes the file data to be saved, and then completes the requested 

command.

NO Causes the file data to NOT be saved, and then completes the requested 
command.

CANCEL Causes the    requested command to be aborted leaving the file data intact.



Dialog: File Open

The File Open dialog box provides the user with a means of specifying the file to be read.    
For additional information, select one of the following:

Objects:
FileName
FilePath
FileList

Actions:
Open
CANCEL



Edit: File Name

This is the name of the file to be opened.    It is appended to the File Path to form a full file 
specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Listbox: File List

This listbox contains all of the files and directories which can be selected as the File Name 
and File Path.



Action: Open

Opens the specified file for input into the program, replacing or augmenting the existing file 
data.



Action: Cancel

Cancels the file opening, and returns with the file data still intact.



Dialog: File SaveAs

The File SaveAs dialog box provides the user with a means of specifying the filename    that 
the file data is to be saved under.    For additional information, select one of the following:

Objects:
FileName
FilePath

Actions:
Save
CANCEL



Edit: File Name

This is the filename the file data is to be saved into.    It is appended to the File Path to form a
full file specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Action: Save

Saves the file data into the specified file.



Action: Cancel

Cancels the file SaveAs, and returns with the file data still intact.





Menu:File

The File menu includes commands that enable you to open and save checkbooks, establish a
new checkbook, print the checkbook.    Additionally, to register the software and access the 
Check Register.

For more information, select the File menu command name.

NEW
OPEN
SAVE
SAVEAS
SAVE CONTROLS
CHECK REGISTER
REGISTER
PRINTER FONTS
PRINT
EXIT



File New Command

Initializes a new checkbook register.    If there are changes to the current checkbook the Save
Current Changes message will be invoked.



File Open Command

Opens an existing checkbook register.    If there are changes to the current checkbook the 
Save Current Changes message will be invoked.    A file open dialog box is presented to the 
user to assist in the selection of the file.



File Save Command

Saves the current checkbook register back into the file that it came from, overwriting the 
previous contents.



File SaveAs Command

Presents the user with a SaveAs file dialog box allowing for the specification of the file that 
the checkbook register is to be saved into.



File Save Controls Command

Presents the user with a Save file dialog box allowing for the specification of the file that the 
control data will be written to.    Starting with the selected checkbook register entry (or the 
first in none is selected) thought the ned of the register.    The format of the file is Control 
first then Amount of the transaction.



File Check Register Command

Activates the Check Register Window.



File Register Command

Activates the Software Registration dialog box.    By completing this dialog and mailing it, 
along with the registration fee you are provided a registered copy of this application.



File Printer Fonts Command

Allows for the specification of the printer font you wish the checkbook register to be printed 
in.



File Print Command

Prints the checkbook register from the currently selected record (or beginning if none is 
selected) to the end of the register using the font selected via the PRINTER FONTS command
from the FILE Menu.



File Exit Command

Exits the checkbook application.    If there are changes to the current checkbook the Save 
Current Changes message will be invoked.



Menu:Edit

The Edit menu includes commands that enable you to move data to and from the clipboard 
as well as delete data without moving it.

For more information, select the Edit menu command name.

CUT
COPY
PASTE BEFORE
PASTE AFTER
INSERT
DELETE
DISBURSE



Edit Cut Command

This will copy the selected checkbook register entry to the clipboard and then delete it from 
the register.



Edit Copy Command

This will copy the selected checkbook register entry to the clipboard.



Edit Paste Before Command

This will copy the checkbook register entry from the clipboard to the checkbook register 
before the selected entry.



Edit Paste After Command

This will copy the checkbook register entry from the clipboard to the checkbook register 
after the selected entry.



Edit Insert Command

This will insert a blank entry checkbook register entry after the currently selected record.    If 
no records are selected it will insert it at the end of the checkbook register.



Edit Delete Command

This will delete the selected checkbook register entry.



Edit Disburse Command

This will send a copy of the currently selected checkbook entry to the Disburse program.



Menu:Options

The Option menu includes commands that enable various program options.    Allowing for 
different display attributes and communication to cooperating packages.

For more information, select the Options menu command name.

Disburse
Register above Entry
Entry above Register



Options Disburse Command

This enables the ability to disburse checks to the Disburse program.    This must be selected 
before you can perform Disburse commands.



Options Register above Entry Command

This will position the checkbook register above the check entry.



Option Entry above Register Command

This will position the check entry above the checkbook register.





Menu:Search

This activates the Search dialog box.    From it you may specify a check register entry to 
search for.



Dialog:Search

The Search Dialog provides a means to locate a specific item in the checkbook register.

For more information, select one of the following.

Types of Search
CheckNumber
Description
Amount

Search String
CheckNumber
Description
Amount

Actions
Search
Don't Search



Type of Search: Check Number

This selects the Check Number field as the search key.    The search is terminated when 
either the check is found, a numerically greater check number is found, or the end of the 
check register is reached.



Type of Search: Description

This selects the Check Description field as the search key.    The search is terminated when 
either the check is found, or the end of the check register is reached.    Regular expression 
searching is not currently supported.



Type of Search: Amount
This selects the Check Credit and Check Debit fields as the search key.    The search is 
terminated when either the check is found, or the end of the check register is reached.



Search String: Number

This represents the code or number of the check to be searched for.



Search String: Description

This represents either the full, or partial description of the check to search for.



Search String: Amount
The represents the Credit or Debit amount of the check.    Both Credit and Debit fields are 
examined when searching by amount.



Search Action: Search

Searching starts at the currently selected checkbook entry and upon termination selects the 
matching item as the current selection.



Search Action: Don't Search

Aborts the search before it is started, leaving the currently selected checkbook entry, if any, 
selected.



Menu: Help

The Help menu includes commands that enable you to obtain help regarding various 
features of the checkbook.

For more information, select the Help menu command name.

Context
Overview
Index
Keyboard
Using Checkbook
About



Help:Context Toggle

Selecting this item has the effect of toggling contextual help on and off.    When Contextual 
help is on the Context Help Cursor is displayed.    When it is off the normal cursor for the field
is displayed.    By positioning the cursor and clicking the left mouse button you can receive 
detailed information regarding the particular item.



Help:Overview Command

Presents an overview of the Checkbook program.



Help:Index Command

Presents a Help index for the Checkbook program.



Help:Keyboard Command

Provides a description of the keys available at a given point.

Register Entry



Help:Using Help Command

Provides the user with information on how to use the help system.



Help:About Command

Displays the About dialog box.



Dialog:About

This dialog box presents general information to the user regarding the software being run.    
For further information select one of the following commands:

Actions:
OK



Action:OK

Select this action button once you have reviewed the About dialog box to remove it and 
return to the application.



Checkbook Entry

The Checkbook entry provides a means to create, modify, and delete entries from the 
checkbook register.    In addition it makes available fields that are not presented in the 
checkbook register.

Check
Date
Description
Memo
Amount

Credit
Debit
Clear
Cleared

Control
Actions

Accept
Forget
Append
Prepend
Delete



Check Entry: Check Number

This is the number of the check.



Check Entry: Date

This is the date of the transaction.



Check Entry: Description

This is the description of the transaction.



Check Entry: Memo

This is the memo for the transaction.



Check Entry: Amount

This is the amount of the transaction.



Check Entry: Credit

This button is used to indicate that the transaction is a credit or deposit.



Check Entry: Debit

This button is used to indicate that the transaction is a debit or withdrawl.



Check Entry: Clear Indicator

This is the Clear indicator.    It is used to indicate that a transaction has been processed by 
the bank.    If a different indicator is used for each month of a bank statement (like the month
of the bank statement) then the Summarize command can be used to summarize all of the 
transactions with identical Clear Indicators.



Check Entry: Cleared

This checkbox is checked if the transaction has cleared the bank.



Check Entry: Control

This is the control that is used by various tax programs.    When the check register is written 
with the File SaveControls command each entry witha    control is written to a file along with 
the control value.    Subsequently, this file can be used as input into a tax preparing program.



Check Entry: Accept

Accept the modifications into the checkbook register.



Check Entry: Forget

Forget the changes made, and go back to the checkbook register without making them.



Check Entry: Append

Accept the modifications into the checkbook register by creating a new record after the 
selected entry.



Check Entry: Prepend

Accept the modifications into the checkbook register by creating a new record before the 
selected entry.



Check Entry: Delete

Delete the selected entry.





Checkbook Register

The checkbook register provides for visual examination of each record in the checkbook 
register.

Fields
CHECK NUMBER
DATE
DESCRIPTION
DEBIT
CLR
CREDIT
BALANCE
STATEMENT

Keyboard
Mouse



Check Register: Check Number

This is the number of the check.



Check Register: Date

This is the date of the transaction.



Check Register: Description

This is the description of the transaction.



Check Register: Debit

This is the amount of the check written, or withdrawal amount.    This will cause the Balance 
to be updated to reflect the amount of the transaction.



Check Register: Clear

This field is non-blank if the transaction has been cleared by the bank.    At the time you 
receive your bank statement you mark all of the transactions pertaining to it as cleared.    
This will cause the Statement to be updated to reflect the amount of the transaction.



Check Register: Credit

This is the amount of the check deposited, or deposit amount.    This will cause the Balance 
to be updated to reflect the amount of the transaction.



Check Register: Balance

This represents the current checkbook balance.    It is effected by Credits and Debits.



Check Register: Statement

This represents the current checkbook statement.    It is effected by Credits and Debits and 
updated whenever the Clear field is non-blank..



Check Register: Keyboard

Since the checkbook register is maintained in a listbox, all of the appropriate listbox keys will
work as documented by Windows.    In addition, the following Keyboard 
extensions are provided.

Key Function
Space Bar Activate the CheckEntry window.
Equal Summarize the transactions.

Move to the previous checkbook register record.
Move to the previous checkbook register record.
Move to the next checkbook register record.
Move to the next checkbook register record.

Page Up Move to the previous page of the checkbook register.
Page Down Move to the next page of the checkbook register.
Home Move to the first page of the checkbook register.
End Move to the last page of the checkbook register.
Insert Insert a new record into the checkbook register.
Control+Delete Delete the selected checkbook register record.
Shift+Delete Cut the selected checkbook register record to the clipboard.
Control+Insert Copy the selected checkbook register record to the clipboard.
Control+D disburse the ceckbook register record to the DISBURSE program.
Shift+Insert Paste the checbook register entry in the clipboard to the register.



Check Register: Mouse

Since the checkbook register is maintained in a listbox, all of the appropriate listbox mouse 
actions will work as documented by Windows.    In addition, the 
following extensions are provided.

Action Function
Dbl Click Left button Toggles the chkbook CLRHELPID_REG_CLR between blank and non-

blank.

The arrow cursor appears to allow the user to select a new record.

The bar cursor appears to allow the user to select between which records a record is 
to be moved or pasted.    If a record has been selected, and you click the mouse when a bar 
appears, the record sleected will be moved to the position occupied by the bar.



Dialog:Summary

This dialog box provides an 'at a glance' summary of transactions that have cleared the 
bank and are marked with identical clr indicators.

For additional information, select one of the following:

Clr Indicator
Deposits/Credits
Checks/Debits
OK



 CLR Indicator

This is the Clear indicator.    It is used to indicate that a transaction has been processed by 
the bank.    If a different indicator is used for each month of a bank statement (like the month
of the bank statement) then the Summarize command can be used to summarize all of the 
transactions with identical Clear Indicators.



Deposits/Credits

This is the total amount of deposits or credits which have cleared the bank and are similarly 
marked with the CLR Indicator.



Checks/Debits

This is the total amount of checks or debits which have cleared the bank and are similarly 
marked with the CLR Indicator.



OK

This action button is selected after you have reviewed the Summary Dialog Box and wish to 
terminate using it.





Logical Font Information

The logical font dialog box provided information about the currently selected printer font.    
The descriptions contained within are taken from documentation provided by Microsoft.

For more detailed information select one of the following:

Height Escapement
Width Orientation
Weight OutPrecision
Italic ClipPrecision
Underlined Quality
Strikeout Pitch & Family
CharSet



Height

Specifies the average height of the font (in user units).    The height of a font can be 
specified in the following three ways.    If the Height field is greater than zero, it is 
transformed into device units and matched against the cell height of the available fonts.    If 
Height is zero, a reasonable default size is used.    If Height is less than zero, it is transformed
into device units and the absolute value is matched against the character height of the 
available fonts. 



Width

Specifies the average width of characters in the font (in device units).    If the Width field is 
zero, the aspect ratio of the device is matched against the digitization aspect ratio of the 
available fonts for the closest match by absolute value of the difference. 



Escapement

Specifies the angle (in tenths of degrees) between the escapement vector and the x-axis of 
the display surface.    The escapement vector is the line through the origins of the first and 
last characters on a line.    The angle is measured counterclockwise from the x-axis. 



Orientation

Specifies the angle (in tenths of degrees) between the baseline of a character and the x-
axis.    The angle is measured counterclockwise from the x-axis. 



Weight

Specifies the font weight (in inked pixels per 1000).    Although the Weight field can be any 
integer value from 0 to 1000, the common values are as follows:    
400 Normal
700 Bold 
These values are approximate; the actual appearance depends on the font face.    If Weight 
is zero, a default weight is used. 



Italic

Specifies an italic font if set to nonzero.



Underline

Specifies an underlined font if set to nonzero. 



StrikeOut

Specifies a strikeout font if set to nonzero. 



CharSet

Specifies the font's character set.    The three values are predefined:
ANSI_CHARSET
OEM_CHARSET 
SYMBOL_CHARSET

The OEM character set is system-dependent.    Fonts with other character sets may exist in 
the system.    If an application uses a font with an unknown character set, it should not 
attempt to translate or interpret strings that are to be rendered with that font.    Instead, the 
strings should be passed directly to the output device driver.



OutPrecision

Specifies the font's output precision, which defines how closely the output must match the 
requested font's height, width, character orientation, escapement, and pitch. The default 
setting is OUT_DEFAULT_PRECIS. 



ClipPrecision

Specifies the font's clipping precision, which defines how to clip characters that are partially 
outside the clipping region. The default setting is CLIP_DEFAULT_PRECIS. 



Quality

Specifies the font's output quality, which defines how carefully GDI must attempt to match 
the logical-font attributes to those of an actual physical font.    It can be any one of the 
following values:    

Value Meaning
DEFAULT_QUALITY Appearance of the font does not matter.
DRAFT_QUALITY Appearance of the font is less important than when PROOF_QUALITY is 

used.    For GDI fonts, scaling is enabled, which means that more font 
sizes are available, but the quality may be lower. Bold, italic, underline,
and strikeout fonts are synthesized if necessary. 

PROOF_QUALITY Character quality of the font is more important than exact matching of 
the logical-font attributes. For GDI fonts, scaling is disabled and the 
font closest in size is chosen.    Although the chosen font size may not 
be mapped exactly when PROOF_QUALITY is used, the quality of the 
font is high and there is no distortion of appearance. Bold, italic, 
underline, and strikeout fonts are synthesized if necessary. 



PitchAndFamily

Specifies the font pitch and family. The two low-order bits specify the pitch of the font and 
can be any one of the following values: 
DEFAULT_PITCH
FIXED_PITCH
VARIABLE_PITCH 
The four high-order bits of the field specify the font family and can be any one of the 
following values: 
FF_DECORATIVE
FF_DONTCARE
FF_MODERN
FF_ROMAN
FF_SCRIPT
FF_SWISS 
The proper value can be obtained by using the Boolean OR operator to join one pitch 
constant with one family constant. Font families describe the look of a font in a general way. 
They are intended for specifying fonts when the exact typeface desired is not available. The 
values for font families are as follows: 

Value Meaning
FF_DECORATIVE Novelty fonts. 
FF_DONTCARE Don't care or don't know. 
FF_MODERN Fonts with constant stroke width (fixed-pitch), with or without serifs.    

Fixed-pitch fonts are usually modern. 
FF_ROMAN Fonts with variable stroke width (proportionally spaced) and with serifs.
FF_SCRIPT Fonts designed to look like handwriting.
FF_SWISS Fonts with variable stroke width (proportionally spaced) and without 

serifs.



Basic Metric Font Information

The Basic Metric Font Information dialog box contains basic information about a physical 
font. All sizes are given in logical units; that is, they depend on the current mapping mode of
the printer.    The descriptions contained within are taken from documentation provided by 
Microsoft.

For further information select one of the following:

Height InternalLeading
Ascent ExternalLeading
Descent AveCharWidth
Weight MaxCharWidth
Italic BreakChar
Underline PitchAndFamily
StrikeOut DefaultChar
FirstChar Overhang
LastChar DigitizedAspectX
CharSet DigitizedAspectY



Height

Specifies the height (ascent + descent) of characters. 



Ascent

Specifies the ascent (units above the baseline) of characters. 



Descent

Specifies the descent (units below the baseline) of characters. 



InternalLeading

Specifies the amount of leading (space) inside the bounds set by the Height field.    Accent 
marks and other foreign characters may occur in this area.    The designer may set this field 
to zero. 



ExternalLeading

Specifies the amount of extra leading (space) that the application adds between rows.    
Since this area is outside the font, it contains no marks and will not be altered by text output
calls in either OPAQUE or TRANSPARENT mode.    The designer may set this field to zero. 



AveCharWidth

Specifies the average width of characters in the font (loosely defined as the width of the 
letter x).    This value does not include overhang required for bold or italic characters.



MaxCharWidth

Specifies the width of the widest character in the font. 



Weight

Specifies the weight of the font. 



Italic

Specifies an italic font if it is nonzero. 



Underlined

Specifies an underlined font if it is nonzero. 



StruckOut

Specifies a struckout font if it is nonzero. 



FirstChar

Specifies the value of the first character defined in the font. 



LastChar

Specifies the value of the last character defined in the font. 



DefaultChar

Specifies the value of the character that will be substituted for characters that are not in the 
font. 



BreakChar

Specifies the value of the character that will be used to define word breaks for text 
justification. 



PitchAndFamily

Specifies the pitch and family of the selected font.    The low-order bit specifies the pitch of 
the font.    If it is 1, the font is variable pitch.    If it is 0, the font is fixed pitch.    The four high-
order bits designate the font family.    The PitchAndFamily field can be combined with the 
hexadecimal value 0xF0 by using the bitwise AND operator, and then be compared with the 
font family names for an identical match.    For a description of the font families, refer to the 
Logical Font Information.



CharSet

Specifies the character set of the font. 



Overhang

Specifies the per-string extra width that may be added to some synthesized fonts.    When 
synthesizing some attributes, such as bold or italic, GDI or a device may have to add width 
to a string on both a per-character and per-string basis.    For example, GDI makes a string 
bold by expanding the intracharacter spacing and overstriking by an offset value; it italicizes
a font by skewing the string.    In either case, there is an overhang past the basic string.    For 
bold strings, the overhang is the distance by which the overstrike is offset.    For italic strings,
the overhang is the amount the top of the font is skewed past the bottom of the font.    The 
Overhang field allows the application to determine how much of the character width 
returned by a GetTextExtent function call on a single character is the actual character width 
and how much is the per-string extra width.    The actual width is the extent minus the 
overhang.



DigitizedAspectX

Specifies the horizontal aspect of the device for which the font was designed. 



DigitizedAspectY

Specifies the vertical aspect of the device for which the font was designed. The ratio of the 
DigitizedAspectX and DigitizedAspectY fields is the aspect ratio of the device for which the 
font was designed. 



Dialog: Printer Font Selection

This dialog box provides the user with a means to specify the printer font that the checkbook
register will be printed with when the File Print command is selected.

For more detailed information select one of the following:

Objects:
Font Name
Font Size

Actions:
Show Logical Font
Show Font Metric
OK
Cancel



Font Name

This is a drop-down listbox that allows the user to select which font name the checkbook 
regster is to be printed with.



Font Size

This is a drop-down listbox that allows the user to select which font size the checkbook 
regster is to be printed with.



Action: Show Logical Font

Selecting this causes the Logical Font information for the selected font to be displayed.



Action: Show Font Metric

Selecting this causes the Basic Font Metric information for the selected font to be displayed.



Action: OK

Cause the specified font to become the font selected for printing the checkbook register.



Action: Cancel

Cancel the specification of a change to the currently selected printer font.





Dialog:Print Field Control

This dialog box allows the user to specify which fields in the checkbook register are going to 
be printed.    For further information, select one of the following:

Toggles:
Check No. Balance
Date Statement
Description Cleared
Credit Memo
Debit Control

Actions:
PrintHELPID_PRINT_PRINT
CancelHELPID_PRINT_CANCEL



Print Specification: Check Number

This is the number of the check.



Print Specification: Date

This is the date of the transaction.



Print Specification: Description

This is the description of the transaction.



Print Specification: Debit

This is the amount of the check written, or withdrawal amount.



Print Specification: Clear

This field is non-blank if the transaction has been cleared by the bank.    At the time you 
receive your bank statement you mark all of the transactions pertaining to it as cleared. 



Print Specification: Credit

This is the amount of the check deposited, or deposit amount. 



Print Specification: Balance

This represents the current checkbook balance. 



Print Specification: Statement

This represents the current checkbook statement.



Print Specification: Memo

This is the memo for the transaction.



Print Specification: Control

This is the control that is used by various tax programs.    When the check register is written 
with the File SaveControls command each entry witha    control is written to a file along with 
the control value.    Subsequently, this file can be used as input into a tax preparing program.



Action: Print

Print the checkbook register, starting with the first selected checkbook register entry, 
through the end of the register.



Action: Cancel

Don't print the register.



Dialog:Abort Print

This dialog box allows the user to abort printing the checkbook register.    For further 
information, select one of the following:

Actions:
CancelHELPID_ABORT_CANCEL



Action: Cancel

Aborts the printing of the checkbook register.
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 This is the cursor that is displayed when context sensitve help is enabled.



 This is the cursor that is displayed when you are selecting a field to edit or a checkbook 
register entry.



 This is the cursor that is displayed when you are selecting a spot in the checkbook register 
to either move or paste an entry.    The new entry goes where the cursor is located.



Inserting a new checkbook register entry

When you first start the Checkbook software it will display an empty checkbook register.    
Select Edit/Insert or press the Insert key to insert a blank record.    Automatically, the cursor 
will move into the Check Entry window, where you may enter your information.    When you 
are done, press Enter, or Click on Accept to accept the entry.    At any time you may enter a 
new checkbook register entry simply by pressing the Insert key, the new entry will be placed
after the currently selected entry.



Moving a checkbook register entry

There are several means to moving a checkbook register entry.    You can Cut the selected 
entry and then select where you want it to go and either Paste Before or Paste After the 
selection.    Or, you may select it, move the mouse to where you want the recrod to be 
moved (the cursor should chage from an arrow to a bar) and click the mouse to move the 
record.


